The titling and graphics tools in Premiere Pro use a modern graphics engine and cross-application technologies. This guide shows how to take advantage of these capabilities to create and stylize beautiful titles in Premiere Pro. If you have been using the Legacy Titler, this guide will help you transition your workflow. If you have collections of legacy titles, this guide explains the options for upgrading legacy titles for new projects.

The "Titler" was introduced in Premiere Pro in 2002. In 2016, we renamed it to "Legacy Titler." Starting with the 23.0 release, the Legacy Titler will no longer be available in Premiere Pro.

Please note: this guide references features that might not be available in older versions of Premiere Pro.

Key concepts
The new title and graphic creation workflow includes multiple tools that work together to allow content creation right in the Program Monitor.

Much of the creative process with these tools will be familiar: The principles of good typographic design for moving images never change and you’ll find familiar controls for fonts, leading, kerning, tracking, and *Tsume* in the Essential Graphics panel.

The process of adding text, shapes, and graphic elements to a visual composition will require almost no new skills—you’ll quickly discover the locations of the tools and migrate your design skills to use them.

However, there are a small number of key differences in how clips are created and managed. To transition your workflow, you will need to understand these differences. For example, the Legacy Titler included all the titling tools in one panel and created project items that could be saved in folders. This was fairly straightforward to work with, but once you adjust to them, the new tools offer greater flexibility and efficiency.

- New titles are not project items by default.
- Titles can be converted to Source Graphics which do appear in the Project panel and function in similar ways to completed Legacy title project items.
- Animations, like rolls and crawls, can be created easily, though the workflow is different.
- Titles and graphics can be saved as editable templates (Motion Graphic Templates), which you can organize and share in Libraries.
- The Text panel provides powerful tools for reviewing, searching, bulk-editing, and spell-checking the titles in a sequence.
What will happen when the Legacy Titler is retired?

In Premiere Pro v23.0 and later, it will no longer be possible to edit or even view titles created with the Legacy Titler. If you open a project containing legacy titles, Premiere Pro v23.0 will invite you to save a new copy of the project. In the new copy, legacy titles will be automatically upgraded to Source Graphics and renamed with the suffix, 'Upgraded'.

For example, a Source Graphic replacement for a title called **Opening Title** would be called **Opening Title-Upgraded**.

Legacy titles in sequences are replaced with Source Graphics. After you have upgraded a project:

- The new project file cannot be opened in earlier versions of Premiere Pro.
- Your original project file is protected from unwanted changes since you are now working on a separate copy.
- If needed, you can open your original project file in an earlier version of Premiere Pro, including accessing and editing legacy titles.

Because the new tools use a new graphics engine, an upgraded legacy title will not be a pixel-for-pixel copy of the original: Simpler titles will look similar, while more complex ones may require adjustment. Some functions, such as Slant, Distort, or Backgrounds, won't translate – most of these effects can still be achieved with the new tools.

If you prefer to upgrade your legacy titles one by one, or in batches, you can do so using the 22.6 version of Premiere Pro. The Creative Cloud application gives you the option to install multiple versions of Premiere Pro on the same system.

Opening a project with legacy titles

When legacy titles are upgraded, a conversion is applied that matches the original as closely as possible, depending on the attributes of the title (see below).

The entire process is automatic. Since the upgrade recreates the titles using a new graphics engine the results may not look exactly the same, so it's important to check the results carefully, in case you want to make adjustments.

Title Upgrade workflows

When opening a project that contains legacy titles, the workflow you will follow to upgrade them to Source Graphics will depend upon the version of Premiere Pro you are using.

Legacy titles will not render (display) at all in Premiere Pro version 23.0 or later. Earlier versions of Premiere Pro allow you to preview, compare, and export legacy titles because the Legacy titler is still included, along with its renderer.

In Premiere Pro v23.0, when you open a project that contains legacy titles, a notification informs you that your legacy titles will be upgraded.
When you click OK, all legacy titles in the project will be upgraded and replaced (in the project panel and in any sequences).

The replacement titles and graphics have the suffix, '-Upgraded'.

Note: If legacy titles have been added to multiple sequences with different dimensions, a replacement Source Graphic will be created for each, with an additional suffix indicating the file format.

In this guide, you will find detailed descriptions of the expected results of the upgrade process. This includes the legacy title features that you can expect to upgrade accurately, those that may require manual adjustment to achieve the same result, and those which you will need to re-create manually.

**Upgrading legacy titles in an earlier version of Premiere Pro**

The option to upgrade legacy titles was introduced in Premiere Pro v15.4 (June 2021). For best results with upgrading, use the most recent update: version 22.6

When opening a project that contains legacy titles in Premiere Pro v22.6, you will see this dialog:

If you click No, the project will open as usual, and you can upgrade one or more selected titles later (see below).

When upgrading titles using a previous version of Premiere Pro, existing legacy titles are retained in the Project panel along with their Source Graphic replacements, which have the suffix, '-Upgraded.'

Legacy titles are also replaced with their upgraded versions in all sequences.
If your legacy titles are organized in bins, new Source Graphics are added next to them.

Once the upgrade process is complete, check the results carefully. Retaining the original legacy titles allows you to compare the results of the conversion, and to use the original titles as a reference when adjusting the appearance of their upgraded Source Graphics.

You can use the Undo command to remove the new Source Graphics and restore all instances of the legacy titles in sequences.

**Upgrading a single Legacy Title to a Source Graphic**

When you open a project in Premiere Pro v.22.6, you can choose not to upgrade all legacy titles. You can still upgrade them individually:

Select a Legacy Title in the Project Panel and choose Graphics and Titles > Upgrade Legacy Title. You can assign a keyboard shortcut to this command.

After choosing this option, the result for the selected Legacy title(s) is the same as it would be if you had upgraded all titles when you first opened the project:

- A new Source Graphic is added to the Project panel with the same name as the original clip and the suffix ‘-Upgraded.’
- All instances of the Legacy Title incorporated into sequences are automatically replaced with the new Source graphic.
- If your Legacy title is in a bin, the new Source Graphic is added next to it.
- You can use the Undo command to remove the new Source Graphic and restore all instances of the Legacy title in sequences.

This workflow can be applied to multiple selected legacy titles in a single step. Upgrade batches of legacy titles with similar designs to make it easier to review results and make adjustments if necessary.

**Upgrading all legacy titles to Source Graphics**

In Premiere Pro v22.6, if you have an open project that contains legacy titles, you also have the option to upgrade all of them in a single step.

Click the Project panel to make it active and choose Graphics and Titles > Upgrade All Legacy Titles.

After choosing this option, the result is the same as when choosing to upgrade all titles when opening the project:

- New Source Graphics are added to the Project panel for all legacy titles, with the suffix ‘-Upgraded.’
- All instances of legacy titles incorporated into sequences are automatically replaced with new Source graphics.
- If your legacy titles are organized in bins, the new Source Graphics are added next to them.
• You can use the Undo command to remove the new Source Graphics and restore all instances of legacy titles in sequences.
This is the same result as you can expect when clicking Yes in the Upgrade Legacy Titles dialog box that appears when opening the project.

The results of Upgrading to Source Graphics
Some legacy title attributes will be upgraded accurately, and some may require manual adjustment. Some attributes will not translate to new Source Graphics at all. In many cases, you will find you can achieve similar results by applying video effects.

Attributes that will be converted
In Premiere Pro v23.0, the following attributes will be retained fairly accurately when upgrading legacy titles to Source Graphics:

CHARACTER SETTINGS
• Glyphs
• Fill color and visibility
• Font
• Font Size
• Font Style
• Outer strokes with Edge type
• Underline
• Kerning
• Baseline shift
• Small Caps

LAYER SETTINGS
• Shape paths
• Position/Alignment
• Rotation for shapes
• MENA/Indic
• Hindi Digits
• Leading
• Shadow*
• Linear and Radial Gradients*
• Vertical text*
• Sheen*
* These layer settings may look a little different after the upgrade because the way these visual effects are rendered has been updated. Always check the results and compare with original versions.

TRACK ITEMS FILTERS
• Motion and Motion keyframes
• Opacity and Opacity keyframes
• Effects and Effects keyframes

Attributes that will not be converted
The following attributes will not be converted when upgrading legacy titles to Source Graphics.
• Rolls
• Crawls
• Slant
• Inner strokes
• Outer Stroke with type Depth or Drop Face
- Texture
- Background
- Distort
- Rotation for text
- Right to Left text (can be applied after upgrade)
- Track Label Colors
- Tracking
- Tab Width/Stops
- Fill types other than solid, linear, and radial
- Gradients on strokes
- Transparency in gradients

Many of these results can be achieved by combining controls available in the Essential Graphics panel and video effects.

The new titling and graphics workflow

Much of the new toolset for creating and stylizing titles and graphics will be familiar for a Legacy Titler user. Some parts of the workflow are different, but they offer more flexibility and efficiency, once you are familiar with them.

Like titles created using the Legacy Titler, new titles are stored inside the project file, so there is no separate media file to be linked or unlinked. However, new titles and graphics exist as clips in the Timeline panel only. If you want your titles to appear as items in the project panel, you need to upgrade them to Source Graphics.

Similarities between the old and new workflows

Source Graphics work in a similar way to legacy titles in several important ways:

- They have a Project panel item.
- You can track usage in sequences using the Video Usage metadata column.
- Changes made to either the clip in the Project panel or any associated sequence clip instances will ripple through all instances of the clip in the project (including in multiple sequences).
- The Essential Graphics panel, used to make adjustments to title, graphic, and caption contents, is integrated into the main interface.
- You can create templates.

Working with Source Graphics

It is not necessary to upgrade new titles and graphics to Source Graphics.

You can work with titles and graphics directly in sequences; the sequence clip names will be taken from the first text item added.

If you copy a title or graphic in a sequence to another part of the sequence, or into another sequence, changes made to either clip will not update the other.

Title and graphic contents are only linked when you upgrade a clip to a Source Graphic.
To upgrade a title or graphic to a Source Graphic, select the sequence clip and choose Graphics and Titles > Upgrade To Source Graphic.

- The Source Graphic will appear in the Project panel.
- The fx icon on the sequence clip will now have a red underline, similar to the Source Clip Effect indicator.

From now on, changes made to either the clip in the Project panel or any sequence clip instances will update all instances: change one and you'll change them all.

The default clip name for new Source Graphics is Graphic.

- To change the name for all instances, make sure Show Source Clip Name And Label is enabled in the Timeline panel Display Settings menu, then rename any instance of the clip.
- To change the name for a single instance in a sequence, make sure Show Source Clip Name and Label is disabled in the Timeline panel Display Settings menu, then rename that instance.

The Essential Graphics panel

The Essential Graphics panel presents familiar Adobe design tools for creating graphics, titles, and animations. Since they allow you to work on-screen, right in the Program Monitor, you can align them accurately with the composition and timing of your content.

There are two types of titles you can work with in Premiere Pro:

- Titles originally created in Premiere Pro
- Titles originally created in After Effects

The controls and options available for each are different but both can be saved as a new Motion Graphics Template for reuse in multiple projects.

You can create a new title or graphic by clicking in the Program monitor with any of the text or shape tools (see below).

If you would like to re-use a title or graphic that you have created, including any animation, you can:

- Upgrade it to a Source Graphic (which works in a similar way to a legacy title)

or

- Export it as a Motion Graphics template.
Using templates allows you to build libraries of customizable graphics, which can be very time-efficient and provides an easy way to ensure visual consistency across projects.

There are three forms of titles and graphics you might work with in Premiere Pro:

- Newly created clips that exist only in the Timeline panel in a sequence. These clips are always separate from one another, so changing one will not update another.
- Clips that have been upgraded to Source Graphics. These clips are stored in the Project panel or a bin. All instances of a Source Graphic are connected, so changes made to one instance will update all other copies of that clip.
- Motion Graphics Templates (MOGRTs). These can be created from original titles and graphics designed in Premiere Pro or imported from After Effects (see below).

A Motion Graphics template that is applied to the timeline can then be customized (source text, color, font etc) without changing the template stored in the Essential Graphics panel. If you apply a MOGRT multiple times or copy the instances on the timeline, they are unrelated to each other. Customizing one instance does not affect the copies.

**Motion Graphics Templates**

If you use After Effects, or work with a motion graphics designer, you can create advanced editable Motion Graphics templates that leverage the power of After Effects compositions right on the Premiere Pro timeline. See this article for information on [creating Motion Graphics templates in After Effects](#).

In addition, many professionally designed Motion Graphics templates from Adobe Stock are available in the Essential Graphics panel under the Browse tab.

The Essential Graphics panel provides access to settings for titles, graphics, and captions, with familiar controls and easy-access presets.

There are several components that work together to create and adjust titles and graphics in Premiere Pro:

- Use the Essential Graphics panel to set the properties for graphics and titles in much the same way that you would edit text or shape settings in the Legacy Titler. You will find familiar controls, templates and presets, Adobe Stock Motion Graphics Templates, and access to Adobe Fonts.
• Use the **Rectangle, Ellipse, Polygon, Pen, Type and Vertical Type tools** to add content directly in the Program Monitor.

• Use the **Program Monitor** as your canvas to create and adjust titles and graphics, with your content as your frame of reference.

• Use the **Text panel** to navigate, search, edit, spell check, and export titles, and to transcribe sequences and automatically generate captions.
Adjustments made in the Essential Graphics panel update settings in the Effect Controls panel, where you can use keyframes to animate individual objects within a title or graphic. With support for vector motion, this provides more advanced animation control than was available with the Legacy Titler.

See [Creating titles and motion graphics](https://help.adobe.com) in Adobe Help for more information.

**Integration with the Program Monitor**

The new titles and graphics workflow allows you to design titles and graphics right in the Program monitor.

Safe margins, rulers and guides are available and configurable using the Program Monitor Settings menu and the View menu. You can save your guides as a Guide Template, which you can share with others if needed.

Objects in the Program Monitor (such as shapes or text) can snap to corners, the center and edge of the frame, other objects and their anchor points, and guides.

- To display or hide rulers, select Show Rulers in the Program Monitor Display Settings menu (the wrench icon).
- To display or hide adjustable guides, select Show Guides in the Program Monitor Display Settings menu.
- To enable or disable Snapping, select Snap In Program Monitor in the Program Monitor Display Settings menu.
- Right click a guide and choose Edit Guide to change the color, choose pixel or percentage units, and to set the position and orientation.
- To set both rulers to measure pixels or a percentage, right click either ruler and choose an option. To enable or disable these options by selecting them in the View menu, first click in the Program Monitor to make it the active panel.
Captions
The new captions workflow in Premiere Pro allows for fast, automated speech to text transcription and caption generation. The captions toolset also allows you to import and work with standard caption files.

After you have added captions to a sequence, use the Text panel to quickly navigate and edit their contents, and the Essential Graphics panel to change their appearance.

Adjustments made in the Essential Graphics panel can be applied to individual captions or all captions on a track, offering an exceptionally efficient design workflow for long form content.

You can use the default appearance settings for captions or add dramatic and colorful variations—making captions part of your creative content.

You can also create styles for titles and track styles for captions, which function as presets for text. Styles can be shared between projects and organized in bins.

For more information see [Captions workflow in Premiere Pro](#).

Vector Motion
The new titles and graphics workflow supports vector text and shapes, allowing you to scale up and animate titles while retaining crisp edges.

After selecting a title or graphic, you will find Vector Motion, Text, and Shape controls in the Effect Controls panel. While these controls will appear familiar and may even seem to duplicate the Motion controls under the Video section of the Effect Controls panel, they utilize a vector render engine and won’t produce jagged softened edges.

For example, when scaling up using non-vector controls (motion), curves will begin to look jagged because the pixels are being scaled up, rather than the shape.
Note: In addition to the Vector Motion effect, which changes the whole title or graphic, there are separate controls for each layer.

When using vector controls, scaling up will increase the size of the shape itself, retaining clean edges.

Of course, if you want softened jagged edges for creative purposes, the rasterized bitmap-based controls can be used instead, just as they can for other visual media.

**Advanced animation controls**
Each object in a new title or graphic has separate controls available in the Essential Graphics panel and Effect Controls panel. You can use the Selection tool to choose an individual title or graphic object in the Program Monitor (or in the layers list in the Essential Graphics panel) and then modify properties in the Essential Graphics panel for that object.

You will also find that controls for each object you select are automatically highlighted in the Effect Controls panel. Using these controls, you can animate properties using familiar keyframe controls.

**Styles**
Once you have configured the appearance of text exactly the way you want it, use the Styles menu in the Essential Graphics panel to create and update a style.

When you create a style, it appears in the Project panel as an item you can organize, rename, export, and share with other projects.

Any styles that are in the Project panel will appear automatically in the Styles menu in the Essential Graphics panel. To remove a style, delete the Project panel item.

If you modify the properties for text that has a style applied, two buttons will become available next to the Styles menu to either restore the original style or to update the style with the new settings.

Use caution! If you update a style, all titles in your project that use the style will be updated. Always check the results.
Creating and editing titles with the Essential Graphics panel
This section introduces the title and graphic creation workflow. For further information and detailed explanations for the controls available, see the Premiere Pro documentation.

For easy access to the Essential Graphics panel and the tools you’ll use to create and edit titles and graphics, switch to the Captions and Graphics workspace.

Creating a simple title
To create a simple title:

1. Select the Type tool or Vertical Type tool.

2. Click in the Program Monitor viewing area and enter the title contents.

3. A new title with default duration is added to the current sequence on the next available video track, where no existing clips are placed.

4. Like legacy titles, new titles have a default duration of 5 seconds. This duration can be configured in the Timeline preferences, by setting the default Still Image duration.

5. Choose the Selection tool and drag the object to reposition a title. Drag the control handles (white dots) to resize the title.
Each object in a title appears as a layer in the Essential Graphics panel. You can select and object by clicking it in the Program Monitor or by choosing its layer in the Essential Graphics panel.

The Essential Graphics panel has two tabs:

- Use the Edit tab to adjust the appearance of text or graphics, to create, update and apply styles, to align and reposition objects, and to manage layers.
- The Browse tab is where you'll find Motion Graphics templates. Under My Templates, you'll find built-in templates. This is also where you'll find any Motion Graphics Templates that you create or install. Under Adobe Stock you'll find professionally curated Motion Graphics Templates, including many that are free to use.

The Align and Transform, Text, and Appearance settings should be familiar.

Note that you can add multiple Strokes and Shadows by clicking the appropriate + button.

**Adding shapes**

Use the Pen, Rectangle, Ellipse, or Polygon tool to draw shapes in the Program Monitor. Click and hold the Rectangle tool to access the Ellipse tool and the Polygon tool.

If no existing title or graphic is selected in the Timeline panel, a new one will be created on the next available video track. If an existing title or graphic is selected, the new shape will be added as an object in the same clip, and a layer in the Essential Graphics panel.

Any settings you adjust in the Essential Graphics panel apply to the individual object you select in the Program Monitor (using the Selection tool) and in its layer at the top of the Essential Graphics panel.

Hold Ctrl (Windows) or Command (macOS) to select multiple layers in the Essential Graphics panel. Some types of adjustments can be made to multiple selected objects.
When you add a shape or text to an existing title, the new item will be placed at the top of the layer stack, in front of any other contents.

To change the stacking order, drag layers up or down in the Essential Graphics panel.

Use Align and Transform, and Appearance controls in the Essential Graphics panel to reposition shapes and adjust their appearance.

Note that you can adjust the corner radius for shapes.

Adding strokes, gradients and shadows
To edit the properties for a particular object in a title or graphic, select it in the Program Monitor or in the layers list in the Essential Graphics panel.
Alternatively, right click the object in the Program Monitor and choose Edit Properties. The Essential Graphics panel will open, with the object selected and controls available, ready for you to make adjustments.

To change an object’s fill, stroke, background, or shadow color, click the color swatch. Use the color picker to assign a new color.

![Color Picker](image)

To add a linear or radial gradient to a color, choose the gradient type in the Color Picker, then set the Color Stops and Opacity Stops.

![Gradient Settings](image)

For more information on using the Color Picker to add gradients, see the [Premiere Pro documentation](https://helpx.adobe.com/software/typography/using-color-picker.html).

Creating a Sheen effect

The Essential Graphics panel does not include a dedicated Sheen setting but it’s possible to achieve the same result using a linear gradient fill (see above).

Position an additional color stop to narrow the gradient to a thin line. Use the Angle setting to set the angle.

Adding texture: Masking with text

Use masking to add textures or other visual elements to text or shapes. To use text as a mask for background layers, select the text object and enable Mask with Text in the Appearance section of the Essential Graphics panel.
Check the Fill only Mask option to apply the mask only to the fill areas, without impacting strokes (outlines) or shadows.

This effect can be particularly impactful if the background is a still image or video content.

To add a still image or video clip to a graphic, drag the clip from the Project panel into the layer list in the Essential Graphics panel. Alternatively, click the New Layer button in the Essential Graphics panel and choose From File.

**Applying video effects to titles and graphics**

Video effects can be applied to text and graphic content and animated using keyframes in the same way that you would work with video clips.

For example, the Turbulent Display effect can be applied to text and animated to produce complex text warping.

The usual rules apply when adding video effects to titles and graphics: Effects have a stacking order in the Effect Controls panel.

You can place video effects between individual title or graphic object layers in the Effect Controls panel. All layers below the effect will be affected. You can also drag effects directly in the Essential Graphics panel and work with them there.

To limit the results of a video effect to specific title or graphic object layers, add the layers to a group (see below) and drag the video effect inside the group in the Effect Controls panel.

**Saving titles as Motion Graphics Templates**

If you have perfected the appearance or a title or graphic—perhaps using keyframes to add motion and animate effect settings—you can create a Motion Graphics Template (sometimes abbreviated as MOGRT) for future use.
To save a title or graphic as a MOGRT, select the clip in the Timeline panel, open the main Graphics And Titles menu and choose Export As Motion Graphics Template.

Choose a name and destination (this can be your local Templates folder or a Creative Cloud library) and click OK.

The new Motion Graphics Template will be added to the Browse tab in the Essential Graphics panel.

For more information, see Install and Use Motion Graphics Templates.

Creating rolling titles
The workflow for creating rolling titles (vertical scrolling) is similar to the one in the Legacy Titler.

Most editors create the content for rolling titles using a text program. This makes it relatively easy to review spelling and job titles, and to get sign-off before copying and pasting the text into the Program Monitor in Premiere Pro.

1. Copy the original text.
2. Using the Type tool, click in the Program Monitor viewing area and use the Paste command by pressing Ctrl+V (Windows) or Command+V (macOS), or by choosing Edit > Paste.
3. Choose the Selection tool and make sure the text is selected in the Program Monitor.
4. Use controls in the Essential Graphics panel to adjust the appearance of the text.
5. Deselect the text item. This reveals settings in the Essential Graphics panel that apply to the overall graphic clip.
6. Check the box to enable the Roll option. When you enable the Roll option, a navigation bar is added to the Program Monitor to allow you to review the text contents, and additional options for Roll timing appear in the Essential Graphics panel.
7. If needed, you can check the box to enable the Soften option. This applies a vertical Gaussian blur, smoothing the motion of the rolling titles.

To set the playback speed for the rolling title, trim the sequence clip duration.

Creating crawling titles

There are no built-in options for creating crawling titles (horizontal scrolling) but it’s a straightforward effect to achieve

Just as when creating a rolling title, many editors prepare the contents of your title crawl using a text application. Once the content is signed off, you can copy and paste the text into the Program Monitor in Premiere Pro using the Type tool:

1. Copy the original text.
2. Using the Type tool, click in the Program Monitor viewing area and apply the Paste command: Ctrl+V (Windows) or Command+V (macOS), or by choosing Edit > Paste.
3. Choose the Selection tool and make sure the text is selected in the Program Monitor.
4. Use controls in the Essential Graphics panel to adjust the appearance of the text.
5. Set playback duration by trimming the sequence clip.
6. Use Horizontal Position keyframes to animate the text on screen and offscreen, creating the crawl.
Legacy Titler features that are not available in the Essential Graphics panel
As discussed earlier in this guide, not all of the Legacy Titler features are available in the Essential Graphics panel. Many of these effects can be achieved by combining properties in the Essential Graphics panel with visual effects.

For example, while there are dedicated settings for rolling titles (vertical scrolling titles), there is no such option for crawls (horizontal scrolling titles—see above).

The following features do not directly translate into the new titles and graphics workflow.

**Depth Strokes**
Depth strokes create the illusion of 3D depth by extending the edge of text or a shape in a particular direction.

While this feature is not available in the Essential Graphics panel or as a video effect, it is available in Adobe After Effects.

If you create an editable Motion Graphic Template in After Effects that includes extruded text or shapes, you can use (and re-use) that template for titles in Premiere Pro.

For more information, see [Extruding text and shape layers](#) in the After Effects documentation.

**Inner and Outer Strokes**
The Essential Graphics panel allows you to add multiple strokes to text or shapes. These produce a similar result to the Inner and Outer Strokes options available in the Legacy Titler but with different positioning relative to the edge.
Premiere Pro v23.0 includes the option to add Inner and Outer Strokes.

To achieve a result that precisely matches an existing Legacy Title with inner strokes, you may need to reduce the font size slightly.

To change the line join type, line cap type, and miter limit, click the Graphics Properties button.

Text on a path
The Legacy Titler allowed you to draw a path and then add text that followed the path. This option is not available using the new Pen and Type tools, but you can create the same effect using After Effects or Photoshop.

You can incorporate Photoshop files in Premiere Pro graphics as layers. To add a Photoshop .psd file as a layer, choose From File in the New Layer menu at the top of the Essential Graphics panel.

Learn more about working with text in the After Effects documentation or learn about creating text on a path in Photoshop.

Thumbnails for styles
The Legacy Titler included a thumbnail in the Styles browser. Though the Styles menu in the Essential Graphics panel does not include thumbnails, you can view styles in the Project panel in Icon View to see a thumbnail preview.

If you organize styles in the Project panel in a separate bin, that bin becomes an effect style browser.
To apply a style to a title in a sequence, select it in the Essential Graphics panel Styles menu or drag it from the Project panel onto the clip.

**Distort and Slant**

The Legacy Titler included Distort and Slant settings, which adjusted the appearance of text or shapes. These settings are not available in the Essential Graphics panel, though similar options are available in After Effects and Photoshop.

You can apply distortion to whole titles and graphics using video effects such as Corner Pin, Wave Warp, Twirl, Spherize, and Transform, which includes a Skew setting.

**Shapes offered by the Legacy Titler**

The Legacy Titler included shapes that are not available in the Essential Graphics panel, including Wedge, Arc, and Clipped Corner Rectangle.

Using the Pen, Rectangle, Ellipse, and Polygon tool, complex shapes can be created using the new graphics workflow. Corners can be turned into curves by adjusting the Corner Radius setting. When creating shapes using the Polygon tool, you can also set the number of sides.

**Aligning objects as a group**

When multiple objects were selected in the Legacy Titler, the Center Vertical and Center Horizontal commands would use the center of the collective group of objects for the purpose of alignment.

This functionality is available in Premiere Pro v23.0.

In Premiere Pro v22.6, each item is aligned separately.

You can select multiple objects and move them while maintaining their relative positions. You can also add objects to a group to make selecting them faster. To add objects to a group:

1. Hold Shift while you click multiple items in the Program Monitor or in the Layers list in the Essential Graphics panel.
2. Click the Create Group button in the Essential Graphics panel.

From this point, you can select individual objects to move them separately, or click the group name in the Essential Graphics panel layers list and move them all together.

You can drag objects in and out of a group in the Layers list.

When a group is selected it has its own anchor point and Transform controls. For example, adjusting the Scale setting will scale each item in the group around the shared anchor point, increasing and decreasing gaps between objects proportionately.

**Responsive design controls**

The new Responsive Design controls allow you to maintain relative position and scale for multiple objects by pinning them to each other.

This makes it easier to move them as a group. If you move or resize an object that other objects are pinned to, they’ll maintain their relative positions and scale.
By default, objects are positioned relative to the video frame. If one object is moved or resized, none of the other objects are affected.

Title and graphic objects in the Program Monitor are described as layers in the Essential Graphics panel. The language used to describe responsive design positioning is based on layers.

1. To pin one layer to another: Select a layer.
2. Use the Pin To menu to select the layer you would like to pin it to. This is the parent layer (an After Effects term you may already be familiar with).

3. Click to select the edges of the parent layer. If you click the center of the selection, size changes will be anchored in the center. If you click an edge, size changes will cause the pinned layer to expand or contract from that edge.

Now, when you move or resize the parent layer, the pinned layer will follow. Here's an example:

The text and underline (a rectangle shape) in this graphic are separate layers, allowing them to be animated and scaled separately.

The Shape layer is pinned to the Text layer, selecting only the left and right edges for responsive design. Selected edges are highlighted in blue.

All adjustments to the parent layer (the text) will update the graphic layer but only based on the selected left and right edges.

When the font size is reduced, the underline retains its original height but it shrinks horizontally in proportion to the text layer.
Multiple layers can be pinned in this way, allowing complex graphic designs to update dynamically based on a key element, like a single text item.

**Additional workflows**

In most scenarios, you will find it efficient to open a project file containing legacy titles in Premiere Pro (V23.0), allow all titles to be upgraded automatically, then review the results and make adjustments as necessary.

There are scenarios in which you may find it more efficient to complete the upgrade process manually, one title at a time, or one batch of titles at a time, using an earlier version of Premiere Pro (which includes the Legacy Titler).

Below are some additional workflows you may find helpful while navigating the upgrade process.

**Export a still frame of an existing title to use in place or as a reference**

You can export a still frame from the Premiere Pro timeline by clicking the Export Frame button in the Program Monitor or by pressing Shift-E.

Premiere Pro supports including an alpha channel for media exported from sequences and clips, so if you export a still frame that includes a legacy title, with no background, and you use a file type like PNG (which supports an alpha channel). You can use the exported still image as a title in future projects or as a reference when comparing upgraded titles.

**Create one title and duplicate it using a Source Graphic**

The new titles and graphics workflow treats Source Graphics a little like any other source clip with Source Clip effects applied. Any changes made to the effects (or, in this case, the contents of the title or graphic) will update throughout the project, in all sequences that include it.

Using an earlier version of Premiere Pro, which includes the Legacy Titler, you can compare the results of upgrading a title side by side on the timeline:

Duplicate the legacy title in the sequence by selecting it and using Copy/Paste to produce a separate instance, or by holding Option (macOS) or Alt (Windows) while you drag the sequence clip segment to a new position.

1. Position the copy above the original and make sure it’s selected.
2. Choose Graphics and Titles > Upgrade Legacy Title.

The copy will be upgraded to a Source Graphic and you can compare it with the original by toggling the track output or enabling and disabling the clip (to do this, right-click the clip and choose Enable).

You can use Comparison view to review your original and upgraded titles side by side. Place the two versions of the title at different times in your sequence and click the Comparison View button in the Program Monitor to view them side by side or as a split screen.

Learn more about configuring and using Comparison View in Premiere Pro.

**Further resources**

For further information about the Essential Graphics panel, the Text panel, the Type tools, Shape tools and captions, see the Premiere Pro documentation.

For information on the Legacy Titler retirement, see this FAQ.

For help with other Adobe Creative Cloud questions, visit https://helpx.adobe.com/support.html